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FAPTURBO License Agreement
All contents of the FAPTURBO web-resource and User Manual are neither an endorsement, nor 
a solicitation of any sort, and cannot be considered as a promotional offering. All information 
you  receive  is  unsolicited,  private  encoded  communications  of  privileged,  proprietary,  and 
confidential information for you only and by purchasing the given product you agree to keep this 
information  private,  confidential,  and  protected  from  any  disclosure.  You  also  agree  to 
indemnify  and hold  harmless  the  authors  of  FAPTURBO, their  employees,  contractors,  and 
service providers. Should any of the practices described herein turn out to be unlawful in any 
jurisdiction, individuals pursuant to its legislation should restrain from any intentions or attempts 
to  apply  them in  any  manner,  either  personally  or  in  partnership  with  other  individuals  or 
entities.  Unauthorized  copying  and  distribution  of  all  or  parts  of  this  product  are  strictly 
prohibited and will result in civil liability and criminal charges brought against the violators and
their aides.

U.S. Government Required Disclaimer - Commodity Futures Trading Commission Futures and 
Options trading has large potential rewards, but also large potential risk. You must be aware of 
the risks and be willing to accept them in order to invest in the futures and options markets. 
Don't trade with money you can't afford to lose. This is neither a solicitation nor an offer to Buy/
Sell futures or options. No representation is being made that any account will or is likely to
achieve profits or losses similar to those discussed on this web site. The past performance of any 
trading  system  or  methodology  is  not  necessarily  indicative  of  future  results.

Risk Disclosure:  Trading foreign exchange on margin carries a high level  of risk and is  not 
suitable  for  all  investors.  The  high  degree  of  leverage  can  work  against  you.  As  with  all 
investments, you should not invest money that you cannot afford to lose. Before deciding to 
invest  in  foreign exchange,  you must  carefully consider  your  investment  objectives,  level  of 
experience, and risk appetite. Additionally, you must be aware of all the risks associated with
foreign exchange trading and seek advice from an independent financial advisor. Past results are 
not necessarily indicative of future success. Your actual trading may result in losses as no trading 
system is guaranteed. You accept full responsibilities for your actions, trades, profit or loss, and 
agree to hold FAPTURBO and any authorized distributors of this information harmless in any 
and all ways.

CFTC RULE 4.41 - HYPOTHETICAL OR SIMULATED PERFORMANCE RESULTS HAVE
CERTAIN  LIMITATIONS.  UNLIKE  AN  ACTUAL  PERFORMANCE  RECORD, 
SIMULATED RESULTS DO NOT REPRESENT ACTUAL TRADING. ALSO, SINCE THE 
TRADES HAVE NOT BEEN EXECUTED, THE RESULTS MAY HAVE UNDER-OR-OVER 
COMPENSATED FOR THE IMPACT, IF ANY, OF CERTAIN MARKET FACTORS, SUCH 
AS  LACK  OF  LIQUIDITY.  SIMULATED  TRADING  PROGRAMS  IN  GENERAL  ARE 
ALSO SUBJECT TO THE FACT THAT THEY ARE DESIGNED WITH THE BENEFIT OF 
HINDSIGHT. NO REPRESENTATION IS BEING MADE THAT ANY ACCOUNT WILL OR 
IS LIKELY TO ACHIEVE PROFIT OR LOSSES SIMILAR TO THOSE SHOWN.

Your  purchase  of  any  FAPTURBO  products  serves  as  your  acknowledgment  and 
representation that you have read and understand these TERMS OF USE and that you 
agree to be bound by such TERMS OF USE ("Agreement")



Introduction

FAPTURBO  (FAP  stands  for  ForexAutoPilot)  was  developed  by  a  team  of 
professional Forex traders and programmers under the permission of Marcus B. 
Leary and his team. The FAP system rapidly gained world popularity and became 
the top-selling Forex product available on the market. Nowadays, FAP has over 
55,000 members. 

FAPTURBO Package includes:

1. FAPTURBO EASY INSTALLER (Setup Wizard)

2. FAPTURBO USER GUIDE 

3. VIDEO TUTORIALS (in Member Area)

4. VIRTUAL PRIVATE SERVER (Optional)



General Information

• FAPTURBO Expert Advisor (robot) is a unique trading robot that 
monitors the market situation 24 hours a day and makes trades 
for you! 

• You should keep your  Metatrader4 trading  platform on all  the 
time, even if  you are away or asleep, to let the Expert Advisor 
work properly! The Expert Advisor will do all the work for you to 
bring you excellent profit! 

• You can order a Virtual Private Server (VPS) which can host the 
Metatrader4 trading platform securely.  This  allows you to turn 
your PC off. (VPS is optional).

• Metatrader4  brokers  are  open  5  days  a  week.  No  trades  are 
performed on weekends. 

• The FAPTurbo Expert Advisor is an .ex4 file is not executable by 
Windows. It is a script (plugin) for Metatrader4 and can be run 
only inside Metatrader4 software.

• Metatrader4 is a free trading platform. You can download it from 
your broker's website.

• Each open trade will display a loss when it is first opened because 
you  pay  the  spread  (cost  of  the  trade)  to  the  broker.  This  is 
normal. Sooner or later the majority of trades will  be closed in 
profit.



Description of the Trading System

FAPTURBO IS A POWERFUL COMBINATION OF 2 STRATEGIES:

• Short Term Scalping Strategy 

• Long Term Advanced FAP strategy

Both strategies are built inside one FAPTURBO expert advisor and you can select 
which  one  to  use  with  the  “UseScalperStrategy” parameter  in  FAPTURBO 
settings. 

Each strategy uses its own designated timeframe and currency pairs so be sure 
you use the correct strategy on the correct currency pairs and timeframe. Read 
the next part of the Guide for more details on each strategy. FAPTurbo will not 
work at all unless the correct strategy, currency pair, and timeframe is selected.

Only one strategy can work on one Chart at the same time. You can open several 
charts  to run different strategies   and currency pairs  within the same trading 
account. More details on how to do this can be found later in this Guide.



Short Term Scalping Strategy

FAPTURBO scalping strategy is not a “traditional” scalping method where traders 
play  within  the  spread  (difference  between  the  buy  and  sell  prices)  making 
hundreds of small trades in a short period of time. Such systems are very unstable 
and are not allowed by most brokers.

FAPTURBO scalper is instead a unique system which most often makes 1-5 trades 
a day, aiming for small take profit value (from 6 to 10 pips) each time. It trades 
during a period when the market is both stable and predictable (night time GMT).

By default scalper strategy does not make any trades during the day time (GMT) 
and does not trade on Fridays, when the market is too unpredictable. No trades 
happen over the weekend since brokers are closed at this time.

Scalper strategy is very safe because it uses advanced stoploss system- a complex 
algorithm monitors and closes a number of losing trades before they even hit the 
stoploss value.

FAPTurbo has a Stealth Mode which protects you from cheating on the broker's 
side.  When  using  the  stealth  mode  take  profit  and  stop  loss  values  are  not 
displayed to broker, instead FAPTurbo monitors its own trades and closes them 



out at the right time. An emergency “fake” stoploss is placed with your broker to 
further protect you in case of a disconnection.

Scalper strategy works on EURGPB, EURCHF, GBPCHF or USDCAD currency pairs 
on  the M15 (15 minute) timeframe only.

GMT OFFSET is a VERY important parameter for scalper strategy. It is defined as 
the offset in hours between GMT and your broker time (displayed on the market 
watch window in  Metatrader4).  It  is  automated  in  the  last  Fapturbo  versions 
(since V47).

MaxSpread is  another  vital  setting  for  the  scalper  strategy.  3-4 pips  is  a  safe 
spread for EURGBP, 5 pips is a risky spread. For other pairs allowed spread can be 
higher. We do not recommend trading with a higher spread for this currency pair. 
Maxspread is  set at 5 by default,  so all  trades which are attempted at higher 
spreads will be blocked.

“Spread” is the difference between Bid and Ask Price (a.k.a 'buy' and 'sell' price) 
for the currency pair in question. If price is 0.8147 / 0.8150 that means Spread = 3 
pips. Some brokers have an digit on their quotes (5 numbers after the decimal 
point). In this instance you need to divide your final figure by 10, since the 5th digit 
is actually a tenth of a pip.  e.g. price quote is 0.81477 / 0.81507, the spread here 
is still 3 pips. 

If scalper strategy does not open any trades for a week (and you are sure that you 
have  set  all  parameters  correctly)  it  could  mean that  your  broker's  spread  is 
unacceptably  high.  In  this  case  you  should  change  to  “Fapturbo  Long  Term 
Strategy”, increase your “maxspreads” setting (risky), or find other broker.

Now let's analyze the scalper strategy and find out the weak and strong points.

The weak points:

• Scalper  strategy  has  very  small  take  profit  from  6  to  15  pips  so  it
is very sensitive to the spread size. If you broker gives you an unusually big 
spread (for example spread 8-15pips for EurGbp or more instead of the 
normal 2-4pips) then scalper strategy will have a hard time trading. It will 
miss a lot of trades or will not trade at all. Ask your broker what the spread 
sizes are if you are not sure, or check out the information shown on the left 
of the chart when FAPTurbo is attached.



• Scalper  strategy  does  not  work  well  in  abnormal,  fast  moving  (volatile) 
market conditions. It also does not perform well if there is a strong trend. It 
is  a  good  idea  to  avoid  times  when  this  is  more  likely,  such  as  major 
holidays (Christmas, New Year & Easter being the most important). 

Strong points:

• Very  safe.  Scalper  strategy  has  a  fixed  inner  stop  loss  and
accurate  trading  signals  so  that  both  the  risk  and  any  drawdowns 
associated with losing trades are kept as low as possible.

• Extremely profitable. Scalper strategy is extremely profitable, aiming for 
small consistent gains. It is possible to literally double your deposit in a 
matter of weeks. 



Long Term Advanced FAP Strategy

FAPTURBO uses an advanced FAPS (ForexAutoPilot) Algorithm.

The  Trading  system  of  the  original  ForexAutoPilot  expert  advisor  is  based  on 
several  modern  Forex  indicators  such  as  Alligator,  Fractals,  DeMarker,  and 
William's Percent Rate. The system detects a good trend and confirms it using 
internal  indicators,  then  opens  the  trades  to  make  maximum  profit  for  you. 
ForexAutoPilot expert advisor monitors each open trade carefully and closes it at 
the correct take profit level.

The FAPTURBO developers have added a large number of new features to the FAP 
Algorithm to make it:

• More Safe. Now FAPTURBO uses a fixed stop loss value so your possible 
losses will be small and limited. A great number of additional safe filters 
and indicators were added to prevent trading in risky conditions.

• More Profitable.  Advanced filters and indicators that were added to the 
system make sure  FAPTURBO avoids  risky  periods with unstable market 
conditions and makes the most of the profitable trades with high accuracy.

FAPTURBO Longterm FAP STRATEGY was optimized for the best performance on 
EURUSD  pair  M1  (1  minute  timeframe).  However  you  can  run  it  on  other 
timeframes as well(strongly not recommended for beginners).

Note: To enable long term strategy the UseScalperStrategy parameter must be in 
FALSE position.

FAPTURBO Long Term Strategy is optimized to avoid trading during risky market 
conditions.  No  trades  will  be  opened  on  these  dangerous  days.  Please  have 



patience, if there are no new trades for a week or two that means the market is in 
a risky zone! 

Let's look at the strong and weak points of the long-term strategy.

Weak points are:

• It  does  not  trade  very  often;  so  don’t  expect  many  trades  each  day. 
FAPTURBO Long Term Strategy is optimized to avoid trading during risky 
market  conditions.  No trades  will  be opened on these dangerous days. 
Please have patience, if there are no new trades for a week or two that 
means the market is in a risky zone.

• Trades  can  stay  in  drawdown  for  some  time  until  they  reach  a  profit. 
Expect to have a drawdown for a day or even a week until a trade finally 
reaches the profit target. This is normal for this strategy. Try not to panic if 
you see your trade losing money, the drawdown is limited by a fixed stop 
loss.

• Requires  a  large  amount  of  capital.  Trade  long  term  strategy  with  0.1 
standard lots for capital $10K or above. Do not use long term strategy for 
small deposits.

Strong points are:

•  Fapturbo Long term strategy does not care about the spread size and the 
volatility of the market. 

• It has a  larger value than the scalper strategy for take profit.

• Fapturbo Long term strategy is a very complicated system and can adapt to 
nearly all market conditions. It behaved well and made good profit even in the 
difficult market conditions towards the end of 2008. It can survive nearly all 
hardships and bring you profit over a period of time.

Trading the long-term strategy you should take into an account that your goal is 
to  make  a  profit  long  term.  You  should  check  your  results
monthly or quarterly, not every day or every week. The idea here is to make you a 
profit in the long run. So have patience and you will be amazed by how well it 
works!



What Is an Expert Advisor?

Q: What is an Expert advisor (EA)?

A: Why do 90% of Forex traders lose? Traders are humans, and, like all humans, 
we suffer from greed. Like all humans, in crucial moments (or market conditions), 
we lack confidence, we have fear of what might happen, and most importantly, 
we are usually (90% of the time) inconsistent. Taking this into consideration, 90% 
of traders WILL LOSE MONEY IN FOREX. They will consistently give away their 
money to the other 10%. 

This, together with the often believed misconception that it is possible to become 
a millionaire overnight following a "guru's" trading system from an ebook, is what 
keeps the Forex market a great business for Forex brokers and “guru's” alike. If 
you really understand this, then you can actually MAKE MONEY IN FOREX! How? 
The easiest way to do it is using a profitable expert advisor. 

An Expert Advisor is an automated robotic script written in MQ4 language that 
can work in the Metatrader4 platform and make trades for you! 

An Expert Advisor is a trading "robot". Robots beat humans at chess, and they 



beat humans at trading. An EA robot will watch the market for you, placing trades 
according to certain parameters (strategies), avoiding the fear, greed, lack of 
confidence and inconsistency which characterizes most traders. 

The Expert Advisor has a plan. It sticks to it no matter what, no matter how ugly 
or uncertain the market looks. It is not effected by emotion as human traders are 
and it can work 24 hours a day for you. 

Expert Advisors can only work when the connection to the Internet (in 
Metatrader4) is established. You must always keep your Metatrader4 online and 
working to let the Expert Advisors trade. If you close Metatrader4, Expert 
Advisors cannot monitor the markets which (if you have a trade open at the time) 
could result in possible losses. 

Q: What if my PC lost power or rebooted?

A: No problem here! Just run Metatrader again and turn on the expert advisor. It 
will continue trading. If you have continuous power losses and poor internet 
connection or simply cant keep your PC online all the time we suggest that you 
order a VPS (Virtual Private Server) for hosting your trading.

Q: How do I remove the Expert Advisor?

A: To remove an Expert Advisor, just right click on its name or on the face in the 
top right part of the chart and select «Expert Advisors -> Remove». Do not forget 
to close any trades which are open at the time you do this, since they will no 
longer be managed by FAPTURBO. 

Q: Important: Demo or Real account? 

A: You should always test your advisor on a Demo account first to check if your 
broker is compatible with your current Expert Advisor! NEVER trade on Real 
account without testing on Demo first!

It could be that your broker takes too long processing orders, gives bad quotes or 
has too high a spread or slippage (errors will appear in the journal if this is the 
case). If so, we recommend you try a Demo account with another broker.



Q: How do I run several Expert Advisors on one account?

A: That is very easy. You can run several Expert Advisors at the same time to 
increase your profits and minimize risk. Open several Price Charts and attach each 
Expert Advisor to its own chart. This way, they can all work at the same time. Do 
not try to attach two Expert Advisors to the same chart- this will not work! 

Warning: You should NOT run too many Expert Advisors if your deposit is small. 
Try on a DEMO account first to observe how they work together. Some of the 
advisors are incompatible with each other and/or work poorly if you run them 
with other Expert Advisors.  If you get bad results – do not run those Expert 
Advisors together or change your broker. 

Q: What timeframe and currency pair should I choose?

A: Most of the robots work only on specific timeframes and currency pairs. For 
example, FAPTURBO advanced FAP strategy was created for EURUSD pair on M1 
timeframe.  FAPTURBO short term scalping strategy works on EURGPB, EURCHF, 
GBPCHF or USDCAD currency pairs on M15 timeframe only. The best performing 
pairs are EURGBP and EURCHF.

Q: Which Expert Advisor and strategy is the best one?

A: There is no clear answer to this question. Every Expert Advisor uses its own 
unique system of trading, and each has its own strong and weak points. We 
recommend running several Expert Advisors at the same time and testing them 
on Demo to find out which one works best for you.

Q: How do I run a backtest?

A: To perform a backtest, you should open Metatrader4, go to main menu View -> 
Strategy Tester (CTR+R) or press F6 (if the Expert Advisor is attached to a chart 
already). Then you should set the parameters, currency pair, timeframe and time 
period and then hit “start”. Do not forget to download historical data first from 
the HISTORY CENTER (F2).  



Getting started
Just  follow  the  easy  step-by-step  instructions below  to  get  started  with 
FAPTURBO: 

1. Download  and  install  the  Metatrader4  (MT4)  platform.
You can choose any broker  that  supports  Metatrader4.  We recommend 
IAMFX.com broker with Metatrader4. It provides low spread and free VPS.

 http://iamfx.com/ <= Read more and apply for the account 

2. Download  and  install  FAPTURBO  using  Easy  Installer  (Setup  Wizard)
Read the corresponding chapters of this Guide for more information 

3. Attach the FAPTURBO Expert Advisor to the chart, activate it and let it trade 
for you!  FAPTURBO will analyze the market and trade for you 24/5, even 
when you are asleep or away! Just keep your Metatrader platform on and 
connected to the internet. 

Watch the Video Tutorials!

  Please  open your  member  area on  the FAPTURBO.com website  and 
watch the video tutorials.

http://iamfx.com/


Step 1: Download and install the Metatrader4 
(MT4) platform

You  can  choose  any  broker  that  supports  Metatrader4  platform  such  as 
IAMFX, Alpari, InterbankFX, FXCBS, FXDD, ForexMeta etc. Feel free to use your 
existing brokerage account or choose one by yourself. 

As you know it is very important to get really low spreads for fapturbo to be 
more profitable! That how we found Iamfx, new STP raw spread broker (US 
based).  
This brokerage welcomes fapturbo clients with open arms and offers free VPS 
for its members, fast execution and really low spreads on FapTurbo`s trading 
pairs. 

http://iamfx.com/ 

ForexMeta broker (FXDD) with Metatrader4:

http://www.forexmeta.com/forex  (includes a $500 USD signup bonus*) 

• $500 Bonus Opportunity 
• Real-Time Executable Quotes 
• 24 Hour Customer Support 
• Competitive Spreads 
• Ability To Open Any Account Type 
• Extremely Reliable Platform 
• Automated Trading Capability 
• Free Platform 
• Fast And Easy Execution 

http://www.forexmeta.com/forex
http://iamfx.com/
https://www.iamfx.com/


• Advanced Charting with Numerous
Indicators and Line Studies 

• Capability To Trade From Your Charts 
• Autostrategy Feature So You Can Program

Your Own Strategies 

• The $500 bonus credit to the account is subject to the client completing at least 40 full lot closed 
trades within the first 60 days of the account approval. Bonus is provided only by ForexMeta broker, 
not by FAPTURBO developers. Other brokers do not provide this signup bonus.

New Fapturbo ECN Broker promises big gains!

As promised fapturbo relationship building with brokerages never stops. We are consistently on the 
lookout for THE broker that allows us and the fapturbo community the absolutely biggest gains 
possible. The FXCBS Partnership came about! 

We called out and one of the first broker that listened was FXCBS. This brokerage welcomes fapturbo 
clients with open arms and offers:

• Anonymous ECN trading via MT4 (means awesome conditions for fapturbo users) 

• No Dealing Desk (they do not profit when you loose) 

• inter-bank prices & liquidity (no more small gains only but fapturbo can run as fapturbo was 
meant to run!) 

• Spreads as low as 0.1 pips 

• Competitive spreads on FapTurbo`s trading pairs (EURGBP & EURCHF) 

• Mini lots trading (10,000 of Base Currency) 

• Scalping is welcome (hallelujah) 

• No Re-quotes (orders WILL be executed) 

• 24/5 Customer support 

•

 http://fapturbo.com/brokers.html <= Read more and apply for the account 

http://fapturbo.com/brokers.html


Step 2: Download and install FAPTURBO 
Expert Advisor using EASY INSTALLER

Perform this step only when you have successfully installed Metatrader4 on your 
computer. Download the FAPTURBO Easy Installer (FapTurboSetup.exe file) from 
your members Area on the FAPTURBO.com website and run it. 

FAPTURBO Installer works on Windows 2000/ XP / Vista. 

Follow the steps in FAPTURBO Installer (Setup Wizard). It will guide you through 
the setup process.



During  the  installation  process  the  Setup  Wizard  will  ask  you  to  specify  the 
Metatrader4 software root folder. It is the exact folder where you installed your 
Metatrader4 Platform previously. 

The path depends on the broker you use. It is often found in Program Files on Disk 
C: 

C:\ProgramFiles\MetaTrader - Iamfx

C:\ProgramFiles\Alpari Metatrader

C:\ProgramFiles\ FXDD - MetaTrader 4

C:\ProgramFiles\ FXCM - MetaTrader 4

C:\ProgramFiles\ Interbank FX - MetaTrader 4

Or another similar format. It should be the root  (main) folder of Metatrader.

 



Known Questions and Problems:

I do not have Metatrader4?
You can get the Metatrader4 platform for free on your broker's website(it should be the broker, 
which works on Metatrader 4 trading platform). 

Easy Installer (Setup Wizard) does not work for me!
In this case you can install manually. Just download the fapturbo files from the FAPTURBO ZIP 
Package (can be found in member area download section) and then place Fapturbo.ex4 file into the 
/experts folder and fapturbo3.DLL  file into the libraries folder in your Metatrader directories. The exact 
filenames may vary from those shown above due to new versions being released.

I have MAC OS. Can it work on MAC?

Metatrader4 was created for Windows only but there are two ways you can still use it on a 
MAC OS. The first way is to setup Metatrader on Mac OS following this  short manual. The 
second way is to order a VPS Service that can work with MAC OS without any problem. 

I Don't have WinZip.
You can download the free WinZip Evaluation Version http://www.winzip.com/downwz.htm to 
extract the Zip archive or just use the free WindowsXP/Vista zip service. You can also use the 
free WinRAR to unzip files: http://www.rarlab.com/ 

Watch the Video Tutorials!

  Please  open your  member  area on  the FAPTURBO.com website  and 
watch the video tutorials!

http://forum.mql4.com/11239


Step 3: Open your Metatrader software
Run the Metatrader4 platform and login to your Demo or Real account. If you are 
running FAPTURBO for the first time we recommend that you trade on Demo until 
you feel confident with the system. You will see the list of Expert Advisors under 
the Navigator Panel on the left of the screen. FAPTURBO will be among them: 

Known Questions and Problems:

Why are some expert advisors shown in grey?

Expert Advisors which are colored grey indicate that the original source code is not available for 
viewing/editing. They will still work the same way as Expert Advisors showing in yellow. 
Template MT4 experts like “MACD Sample” and “Moving Average” are free samples with open 
source and that’s why they are shown in yellow.



I installed Fapturbo to my Metatrader using the installer, but I do not see 
FAPTURBO in the "Navigator" panel.
The problem could be that you have several Metatrader platforms installed on your PC. Check 
that you have installed  fapturbo to the correct folder of the correct Metatrader.

Watch the Video Tutorials!

  Please  open your  member  area on  the FAPTURBO.com website  and 
watch the video tutorials!



Step 4: Attach FAPTURBO EA to the chart
First of all you should set the correct global settings in your Metatrader4 
platform.

Click Tools in main menu - > Options - > Expert Advisors Tab

Make sure you have the same settings as shown on the screenshot below. Enable 
Expert Advisors checkbox must be checked. Allow Live Trading must be checked. 
Allow DLL imports must be checked too. Confirm DLL Function calls must be 
unchecked.

Then click OK to close the window.

Now, make sure the «Expert Advisors» button on the top of Metatrader4 is in 
“pushed” position. When it is turned on to allow Expert Advisor trading it will 
have a green triangle showing like this:

Choose the currency pair you want to trade and open a chart window. To do this 
simply right click on the currency  pair title in the top left panel where the 
currency pairs are listed and choose  the “Chart Window” command.



Once you have opened a chart for the currency pair you want to trade, you then 
need to select the correct time period. For Scalper strategy you MUST choose 
M15, for longterm strategy you MUST choose M1. Make your selection in the 
toolbar at the top of Metatrader4. 

We now need to tell FAPTurbo that we want it to trade on this chart. Drag and 
drop FAPTURBO  from the «Navigator» menu onto the chart window. 

The “Settings” Window will appear. We will go through what to do with the 
settings in the next step.

Known Questions and Problems:

What TimeFrame and Currency should I choose?
Scalper strategy works on EURGPB, EURCHF, GBPCHF or USDCAD currency pairs on M15 
timeframe only.

FAPTURBO Longterm FAP STRATEGY was optimized for the best performance on EURUSD pair 
M1 (1 minute timeframe).



Note : To enable long term strategy the UseScalperStrategy parameter must be in FALSE 
position.

My Metatrader4 crashes when I run the FAPTURBO EA!

That means you did not update the MT4 version to the latest build. Please update it!



Step 5: Check Settings
After attaching  FAPTURBO  to the chart, you will see a window pop up with 
FAPTURBO  Parameters. You need to set the Common Tab parameters: «Long and 
Short positions» and enable the checkbox «Allow live trading» to let advisor trade 
Forex for you. Also check «Allow DLL imports» and «Allow import of external 
experts» and deselect «Confirm DLL function calls».  Check that you have it set 
correctly by looking at the screenshot below:

You can also check and edit other parameters in the “inputs” menu. It is possible 
to load and save presets there. All parameters listed in “inputs” are described in 
this GUIDE later on.

Note: To enable long-term strategy the UseScalperStrategy parameter must be in 
FALSE position.

http://forexwinners.net/


If the UseScalperStrategy parameter is set to TRUE then Fapturbo will trade on 
scalper strategy on this chart.

Then click "OK" to run FAPTURBO. If you set FAPTURBO  correctly to the proper 
timeframe and currency pair, you will see a smiling face in the top right corner of 
the Chart window. This means that the Expert Advisor is working and monitoring 
the market. 

Note: Most Expert Advisors do not open new orders instantly. Be patient- 
FAPTURBO is monitoring the market and opens its trades only when it sees 
conditions which indicate a high probability of success. 

FAPTURBO will open trades when its internal indicators find the proper market 
conditions to open trades. FAPTURBO does not have to open many trades or 
trade every single day! The goal is to make a profit, not to make many trades! 



Usually Fapturbo opens 2-15 trades a week depending on the strategy you have 
chosen. If you followed the steps correctly but FAPTURBO did not open any single 
trade for the last 10 days then you should contact our support team for help and 
assistance.

Brokers are closed on Saturdays and Sundays. No trades will be performed 
during the weekend. There is no need to turn off FAPTURBO during the weekend. 
It will sleep and continue to trades as soon as the broker is open again.

Known Questions and Problems:

When I drag the expert advisor onto a chart, I don't get the smiley face, just an 
X. I follow the procedure but it still doesn't respond.
The Smiling Face icon means that EA works correctly. If you do not see the Smiling Face, just 
click on the “Expert Advisors” button at the top of Metatrader. 

I see the sad face  of the expert advisor instead of smiley face 

If you see the Sad Face that means you forgot to set the “Allow live trading” parameter for the 
expert advisor. Please check the parameters.

How do I change the parameters after I attached the EA to the chart?

Right click on the smiling face and select “Expert Advisors - > Properties” or press F7.



Step 5: Activate your copy
According to the terms & conditions your Fapturbo Member License is valid only 
for Activation of 1 (one) Live real money account and an unlimited number of 
Demo practice trading accounts. You are not tied to 1 PC. You are free to trade 
your account on any Computer at home/office/VPS.

Now it's time to activate your copy of FAPTURBO EA. Just a few minutes after 
attaching FAPTURBO EA you will get the following alert: 

Note: If you don’t get this alert right away that could mean one of several things:

• Today is a non-trading day (weekend or Friday night, for example). Wait 2-3 days for this 
alert to appear. You cannot activate fapturbo during the weekend.

• You forgot to set the correct parameters, for example “Allow DLL imports” in EA 
settings. Check the previous steps carefully.

Record your Expert ID given in the alert. For example my expert ID is 808923445 

Next, go to the website members area. Click on the “download” link and at “Step 
FOUR” you will find a field to input your ExpertID and you account number (given 
to you by your broker): 



Press “Get My Activation Key” button. You will get a key: 

Record the Activation Key you are given. For example my Key is 045614050 

Now open Metatrader4 with FAPTURBO attached to the chart and right click on 
the FAPTURBO Smiling Face on the top right side of the chart and select «Expert 
Advisors -> Properties» or just press F7. 



Click on the «Inputs» tab and scroll down to the «KEY» parameter and fill in your 
Activation Key from the website.

That is it! Your copy is activated and ready to use! 

Known Questions and Problems:

• Where is the Member Area? 
You will have received a link to the member area with your welcome email 
after purchase. Here is the link to Login: http://fapturbo.com/login.php 
Try to find it there or contact our support team with the batch/receipt 

http://fapturbo.com/login.php


number of your payment. You can also try “  Forgotten Password  ” to retrieve the 
lost password to your email.

• I want to change broker.
If you change your broker please contact support with proof of closing your 
old account, such as an email from your broker confirming account closure. 
Please note, that this is the only way to change your Fapturbo activation to 
another broker.

• I do not see the Alert Window with the Expert ID!
It could be that your copy is already activated or you forgot to check 
“enable alerts” and "allow DLL imports" and remove "Confirm DLL function 
calls" in the EA settings. Another possible reason: Today is non-trading day 
(weekend or Friday, evening for example). The alert will only appear during 
trading days.

• My Metatrader crashes when I try to attach FAPTURBO to the chart.
This is most likely because you used an outdated version of Metatrader. 
Please update it to the latest build.

• My FAPTURBO License has expired. What do I do?
We update FAPTURBO every month to make sure it is always up to date 
and in tune with the modern market conditions. You should download a 
fresh version of fapturbo from the member area and install it instead of the 
old version. Each version is usually licensed for 1 month only. All updates 
are FREE to our members.

• Am I tied to one PC?
You are not tied to 1 PC! You are free to trade your account on any 
Computer at home/office/VPS. 

• I want to buy more licenses.
You can buy more fapturbo licenses in member area download section 
(step 4, with $10 discount). Please use a different email address at the 
point where you create your new FAPTurbo login for the new license- you 
must have a different email address login for each FAPTurbo license.

Watch the Video Tutorials!

http://fapturbo.com/login.php?passwordreminder=yes


  Please  open your  member  area on  the FAPTURBO.com website  and 
watch the video tutorials! The following video explaining activations is important 
http://fapturbo.com/activation.htm 

http://fapturbo.com/activation.htm


FAPWINNER.com Service Overview

FAP-WINNER.com is  a special  service for ForexAutoPilot & FAPTURBO clients with premium 
support  (rapid  support,  Live  Chat,  Appointment  Calendar,  Forum,  Phone  support,  Remote 
Assistance) and advanced trading opportunities (Special  FAP settings, Personal Trading Plan, 
Hedging  EA)  as  well  as  weekly  Mentoring  and  Coaching  Classes  and  Seminars/Webinars.  
FAP-Winner was founded by Charles A. Floyd II,  a professional forex trader with 20 years of 
experience. 
FAP-Winner is not a part of FAPTURBO or FAP service, it is a separate product created by 
Charles A. Floyd, II to help you get the most out of your trading. 

FAPWINNER FEATURES & BENEFITS:

1. FOREX AUTOPILOT TRADING SYSTEM (FAPTS & FAPTURBO)

• FOREX AUTOPILOT & FAPTURBO
One of the best Expert Advisors available on the market. Its effectiveness has been 
proven in numerous tests and live trading by over 25,000 members over the last 12 
months 

• FAPTS Settings 
Unique Forex AutoPilot modifications and settings developed and optimized by Charles 
A Floyd, ll for FAPTURBO and FAP. Special FAPTURBO STRATEGY included!!

• FAPTS Trading Plan
Solid money management plan "March to a Million", developed personally by Charles A 
Floyd, ll to work for any account size 

• Hedging / Grid Trader / Fapwinner EA
One of the best hedging EAs available online. Developed personally by Charles A Floyd, 
II, professional trader with over twenty (20) years of experience. 

2. FAPTS HAS BEEN PROVEN EFFECTIVE

• Solid Backtesting Results
Defined Buy/Sell Area 

• Tripled Deposit of Live Account
Want proof? FAP tripled one live trading account! Check out the full and consistent 
trading statement on the FAPWinner website. 

http://fap-winner.com/


• Effective On All Types of Trends
FAP works perfectly on downtrends, uptrends and sideways trending markets! 

• Never Lost Deposit On Backtest
You can backtest FAP for many years and verify that is has never zeroed the equity in a 
single account! 

• Adjustable Settings
You are able to perform your own optimizations to find the absolute best settings for 
you! 

• Works 24/5 On Autopilot
Simply drop and trade! Just attach the FAP EA to a chart, and let FAP work its magic 
trading in the forex market 24 (twenty-four) hours a day, 5 (five) days a week for you! 

• No Forex Skills Required
With our detailed instructions and friendly, personalized support, you won't have any 
problems with the setup, even if you have never traded before! 

3. FAPWINNER MEMBERS AREA

• Personal Members Area
Every member of FAPWINNER is provided access to the secure member area on the 
website. 

• Downloads Section
In the downloads section, every member can access the FAPWinner system files, 
documentation, sound and video archives from the mentoring classes and chat 
meetings 

• FAPWINNER Newsletter
Here our members can read the hot news about current and future FAPWINNER 
projects, learn about upcoming events in the FAPWINNER community, as well as 
schedules for the video and chat meetings 

• Support Section
Here our members can get full, personal help from knowledgeable, award winning 
FAPWINNER support staff, hand picked by Charles. 

4. FAPWINNER DISCUSSION FORUM

• You Are Not Alone!
All FAPWINNER members have access to a private discussion forum where all your 
questions can be answered. You can discuss anything related to FAP including setup, 
effective strategies, usage and settings. 

• Moderators and Administrators
All staff are friendly, polite, responsive and always ready to address your needs! 



5. FAPWINNER VIDEO CHAT MEETINGS

• Join The Live Chat With Other Traders!
All FAPWINNER members have access to the daily and weekly online chat meetings. 
Charles has been famous for his friendly FAPUG meetings held every Sunday and 
Thursday! 

• Video Chat and Webinars
Charles presents his own personal video sessions and mentoring classes as well as Forex 
webinars! 

• Recorded Sessions
Can't attend the meeting? No problem! Get access to the download page with recorded 
sound and video sessions archives! 

• Lots of Traders talking online
You'll be excited by the activity in the chat sessions! Traders from all over the world are 
always here to share ideas and discuss the forex market! 

6. AWARD WINNING SUPPORT

• Live Chat Support
All Gold FAPWINNER members are provided with 24/7 live chat support. Friendly, 
professional support staff are always available to help you online! 

• Fast Response
No more hassles and waiting, no more unanswered emails and phone calls. Charles' 
professional support team has proven itself to be one of the best on the Internet! 

• Tons Of Support Options
You will be amazed by the variety of support options we offer at FAPWINNER. These 
include fast email support, live chat, Skype, instant messaging, 1 to 1 mentoring, remote 
access support, personal appointment scheduling calendar, traders' forum, private 
messaging and much, much more!! 

• Appointment Calendar
Every supreme FAPWINNER member can make a personal appointment with Charles for 
1 to 1 mentoring 

• Remote Access Help
We can help you with your FAP setup, using our remote access software! No more 
problems with the setup even if you are a computer newbie! 

• Mentoring And Coaching Classes!
Not a Forex pro? No problem! Enroll and attend our friendly mentoring classes, 
webinars, or read tons of available literature and instructions! We are always here to 
teach and help you to get started right away! 



7. JOIN THE FRIENDLY TEAM

• FAPWINNER Lifestyle
The FAPWINNER Group is more than just a gathering of moneymakers, we are a family. 

• FAPWINNER Group Is Growing Rapidly
We have over 17,000 members and are growing every day! Our members include all 
kinds of people just like you, from total newbies to forex pros with years of experience. 
FAPWINNER is a place to make friends and develop relationships! 

• Be A Winner With FAPWinner
So what are you waiting for? FAPWINNER is exactly what you need, to get where you 
want to be. Join us right now and become a valued member of the FAPWINNER friendly 
community 

 Join FAP-Winner.com now!

http://fapwinner.com/


VPS Service overview
Article by Uriel Katz

Forex Robots need to be trading 24 hours a day, 5 days a week, using your computer resources. 
Interruptions in the work of the robots may result in missed trading opportunities or money 
lost. Sometimes, you may also be unable to restart your computer or make any action which 
may affect the trading platforms and therefore the robot's work. For example maintenance of 
your computer or new installations may have to be left for the non-trading days. This may be a 
little bit annoying sometimes. 

You may also be afraid that other people will use your computer (like in example your kids). 
You may fear that they might accidentally close the platform of worse even, make a manual 
trade that will cause you losses. And what about a power shortage? What about the system 
being accidentally restarted? No limit to our worries. 

Is there any solution?

YES, it is called a Virtual Private Server (VPS). VPSs are computers based in large companies 
providing access to these computers for a monthly fee, through the Internet. These computers 
are maintained by experts, have strong and updated security hardware and software like 
firewalls and virus protection. They are working most of the week apart from hours of 
scheduled maintenance (and of course unscheduled, should any problem arise). You may 
access and operate these computers through any computer, by remote control (what is called 
terminal-operation). 



You just need access to the Internet, login using your username and password, and you operate 
your VPS. Now you may leave the VPS working, say with MetaTrader platform and a robot and 
close your connection with the VPS. Therefore you may use your home computer as needed for 
anything, without worrying about your robot working in the VPS. Even when you turn off your 
computer it is working. These companies have generally power-backup so they won't be 
affected by power shortages. 

ForexHoster VPS is a perfect solution for hosting your trading.

The Forex Hoster VPS comes with web bases panel. It’s a breeze to get going and 
features:
 

• Easy connecting tool for uploading the FapTurbo robot.
• Preinstalled Metatrader4 platform with a brokerage of your choice
• No hassles with server setup and configurations 
• No server knowledge needed!
• Works for MAC and Windows!

 http://www.forexhoster.com/ 

One more very good reliable EZForex VPS:

 http://www.ezforexhost.com/

http://www.ezforexhost.com/
http://www.forexhoster.com/


Correct Lot Size & Risk
To put it into easy terms, the lot size will define the risk of each trade. 

The larger lot size, the more money you risk and could potentially lose!

FAPTURBO gives you two options to help you control your risk. You can either set 
a  fixed  lot  size,  or  you  can  use  FAPTURBO  money  management  and  allow 
FAPTURBO to choose the correct lot size for you (you can make it more or less 
risky according to your preferences). 

Setting Manual Lot Sizes

To set lot sizes manually:-

•For  Scalper  turn  the  “Scalper_UseMM”  parameter  to  FALSE.  Then  in  the 
“scalper_lots” parameter specify your lot size, eg. 0.1. 

•For longterm strategy simply specify your lot size directly in the “FAPTurbo_Lots” 
parameter. 

If  you set too large a lot size for a small deposit,  even a small  drawdown will 
“wipeout” your account. So please be careful setting lot size. 

If you attach FAPTURBO to 2 charts with same lot size that means you DOUBLE 
your risk (and possible gains). Be careful and consider the risk!

Example for Standard Accounts:

• If you are using a small deposit under $2,000 USD, then set Lots = 0.1

• If your deposit is $ 5,000 then you can set Lots = 0.5

• If you have a large deposit over $10K, then set Lots = 1 or more

How to get FAPTurbo to manage your trade sizes automatically

If you are not sure how to set the correct lot size manually we recommend you 
use the AUTOLOT (Money management) parameter. The advantage of using the 



Money  Management  feature  is  that  as  your  account  grows,  the  lot  size  that 
FAPTurbo chooses to trade will  grow along with it, and if  your account should 
suffer a loss, the lot size will be decreased also. To activate money management 
set Scalper_UseMM = true (for scalper strategy) or FapTurbo_Lots = 0 for the 
Long Term strategy.

When Scalper_UseMM is set to true, FAPTURBO will define the lot size for you 
automatically  based  on  amount  of  risk  you  say  you  want  to  take  in  the 
“LotRiskReductor”  value.  For  example  if  you  set  LotRiskReductor  =  5  then 
FAPTURBO will risk 5% of your available margin to open new position and will 
calculate the lot size properly.

If you are trading with a broker which does not accept microlots (0.01 standard 
lots) then you need to alter the “trade microlots” setting to FALSE in order to 
allow FAPTurbo to calculate lot size correctly. 

**WARNING: LotRiskReductor = 5 does not mean you can lose a maximum of 
5% of your account, it means that 5% of your available margin will be used to 
open a trade. Depending on which currency pair you are trading you could lose 
more, or less than 5% from your account . Also be aware that if you specify a 
risk percentage which when worked out by FAPTurbo, results in a lot size too 
small to trade, then FAPTurbo will instead place a trade equal to the minimum 
acceptable lot size by your broker. e.g. FAPTurbo uses money management and 
arrives  at  a  lot  size  of  0.007.  Most  brokers  will  not  accept  such  a  lot  size, 
therefore the trade placed will be the broker minimum, for a microlot broker 
this would be 0.01 lots**

**WARNING: Be aware of risk on Forex and trade only money you afford to 
loose. Always start on Demo first if you don’t feel confident with the strategy!
**

Watch the Video Tutorials!

  Please  open your  member  area on  the FAPTURBO.com website  and 
watch the video tutorials!



FAPTURBO MENTORING CLASS
Visit our mentoring sessions on www.FapturboMeeting.com

We found that many people would like a more detailed approach to mentoring, perhaps going over 
specific topics in detail. So we have teamed together and come up with a brilliant solution to provide 
this service. We will now be holding weekly indepth mentoring sessions. 

Sessions will last 1 hour.

You will have an opportunity to submit your questions prior to the session, on a first come first served 
basis.

Your questions will be answered LIVE over voice chat by either donnaforex or calexander5. FAPTurbo 
Mike (one of the developers) will also be attending.

We will present the ‘topic’ for the session in detail. We will give you tricks, hints and tips which have 
made our life so much easier and will ensure you gain a deeper understanding of FAPTurbo, how it 
works, and more importantly how you can make it work for you.

Topics will be presented using the new media available to us in the chat room, including remote 
computer viewing so you will be able to see us set up our charts live and run through and explain any 
confusing details to you.

(find out exact schedule on www.FapturboMeeting.com) 

http://www.FapturboMeeting.com/
http://www.FapturboMeeting.com/


FapturboMike on Twitter
Follow Fapturbo Mike on Twitter! Read the latest news and updates, development progress 

and ask your questions! FapturboMIKE on Twitter : http://twitter.com/fapturbomike 

Donna Forex 
DonnaForex is a professional forex trading lady. She helped fapturbo with forum moderations 

and developed her own settings for fapturbo. You can find her on http://www.donnaforex.com/ 

http://www.donnaforex.com/
http://twitter.com/fapturbomike
http://twitter.com/fapturbomike
http://twitter.com/fapturbomike


FAPTURBO PARAMETERS
SHORT TERM SCALPER STRATEGY SETTINGS

Scalper strategy works on EURGPB, EURCHF, GBPCHF or USDCAD currency pairs 
on M15 timeframe only. Historically, the best results have been on the EURGPB 
pair.

To activate Scalper Strategy you should set UseScalperStrategy = TRUE parameter 
in FAPTURBO settings.

• Scalper_Lots – fixed lot size if Money Management is off (Scalper_UseMM 
= false)

• Scalper_UseMM     - turn on/off the money management (auto lot 
calculation)

• Scalper_LotsRiskReductor    - Percent of free margin used to open new 
order. Can be from 1 to 100. It is used only if Scalper_UseMM = true

• Scalper_MaxLots     - Maximum Lot size

• Scalper_GMTOffset      - Broker Time offset from GMT Time. (In Hours)

GMT OFFSET is a very important parameter for scalper strategy. It  defines the 
offset in hours between GMT and your broker time (market watch in MT4).  It 
should be set carefully in order to let Fapturbo work properly. From version 47 we 
introduce  Automated  GMT feature!  No  more  hassles  with  calculating  proper 
offset value. Fapturbo will compare your broker time with global GMT server time 
and set proper GMT offset automatically! However please note you cant use this 
feature  during  backtest!  Use  manual  GMToffsets  only  on  backtest!  Set 
Scalper_UseAutoGMToffset = False.

If you fail to set the GMT offset carefully you can get incorrect backtest results. 
Please be careful! Ask your broker about their GMT Offset if you are not sure, or 
ask on the members forum. 

Please note: If your Market Watch is frozen it is likely that the broker is closed for 
the weekend and therefore the time displayed is not valid for calculating the GMT 
offset. You should wait until your broker is open to set the proper GMT offset 
value.  You  should  also  keep  an  eye  on  any  possible  switch  from  summer  to 



wintertime  which  occurs  twice  a  year.  Some  brokers  switch  the  time  so  you 
should adjust your GMT offset again on these days.

New: 

HOW TO CALCULATE GMT OFFSET?

Example:

If Greenwich Mean Time is 23:33 now and the market watch shows you 0:37 that 
means your GMT offset is 1. (to get from GMT to Marketwatch we added 1).

Do not forget to set the proper GMT offset every time you attach FAPTURBO to a 
chart!

• Scalper_StealthMode            - turns on / off Stealth Mode. The Stealth Mode 
protects  you from cheating  on the broker  side.  When using the stealth 
mode the real take profit and stop loss values are not displayed to your 
broker. (EA opens “fake” values for S/L and T/P)

• Scalper_UseCustomLevels         - Turns on and off the CustomLevels filter

• Scalper_RelaxHours             - the number of hours to miss after hitting stop 
loss

• Scalper_SimpleHeightFilter     - turns on/ off the simple bar height volatility 
filter



• Scalper_TrendFilter            - turns on / off Trend Filter based on the Moving 
Average calculation

• Scalper_TradeFriday            - if true then trades on Fridays

• Scalper_TradeMonday            - if true then trades on Mondays

• Scalper_ProfitLimit  and Scalper_LossLimit  -  You can set  the target  profit 
and loss for the session, when reaching them fapturbo will  stop trading 
during this session. This feature monitors the current equity when you have 
opened positions and displays the calculated equity in Current Profit  on 
chart  ProfitLimit  and LossLimit  are set  in  account  currency,  for  example 
USD represented as dollars and not as a percentage of pips.

• Scalper_OneTrade – if 1 then opens only 1 trader per day      

• Scalper_OneOpenTrade – if 1 the fapturbo will have only one open trade at 
a time no matter how many currencies you trade. That is needed for very 
small accounts.  

• Scalper_ReverseTrade - If you set ReverseTrade = 1 then fapturbo will open 
a trade opposite to its normal signal. That is needed for people who believe 
that fapturbo opens in a wrong direction :) Strongly unrecommended for 
beginners.

• Scalper_StartWorkTimeHour,  StartSessionMinute  and 
Scalper_EndWorkTimeHour, Scalper_EndSessionMinute were added - now 
you can set your own trading interval for Fapturbo. Don't forget fapturbo is 
designed for trading during "low"volume hours and does not trade well for 
every trading session.    

• Scalper_UseFilterMA            - turn on and off the MA global filter.

• Scalper_PeriodFilterMA         - period of filtering МА

• Scalper_PriceFilterMA          - PriceMA_0_6 – the way of calculating MA. 
0=PRICE_CLOSE,  1=PRICE_OPEN,  2=PRICE_HIGH,  3=PRICE_LOW, 
4=PRICE_MEDIAN, 5=PRICE_TYPICAL, 6=PRICE_WEIGHTED 

• Scalper_MethodFilterMA         - – the type of MA. 0=Simple, 1=Exponential, 
2=Smoothed, 3=Weighted 

• Scalper_ExpertComment          - "FapTurboScalper": Comments for log



• Trade  Microlots  -  new parameter.  Some brokers  such  as  FXPRO do  not 
allow microlots so it should be set to false to allow FAPTURBO to work out 
money management calculations correctly. 

• New parameter Slippage has been introduced. By default it is 2. This works 
to help prevent offquotes errors when closing a trade. If fapturbo gets an 
offquotes error from the broker it will agree to lose (or gain) this number of 
pips difference from the point it tried to close at.  (FAPTURBO will keep on 
trying  to  close  trades  if  it  does  get  offquotes  errors  which  adds  extra 
safety).

• Maxspreads. You can define the maximum spread at which you would like 
FAPTURBO to trade. Remember 3-4 is a safe spread for EURGBP, 5 is the 
maximum  allowed  spread.  We  don’t  recommend  trading  with  higher 
spread for this currency pair. For other pairs allowed spread can be higher, 
but in no circumstances should you go higher than 10.  Max spread value is 
no longer represented as an Integer. You can customize settings to include

decimals i.e. 5.1 in place of 5 . This will help members who use brokers with 
fractional lot sizing.



LONG TERM ADVANCED FAP STRATEGY SETTINGS

Advanced FAP longterm strategy works on the EURUSD pair, M1 timeframe only. 
From fapturbo version 47 you can use it on other timeframes as well.

To activate Advanced FAP strategy you should set UseScalperStrategy = FALSE  in 
the FAPTURBO settings.

Advanced FAP strategy has a lot of parameters that can be adjusted only by FAP 
expert traders. If you are a newbie then just use the defaults. We’ve already put 
in  a  lot  of  time  and  hard  work  optimizing  these  parameters  for  the  best 
performance for you so they will work very well. All you need to do is set the 
proper lot size for your deposit or use autolot.

• FapTurbo_Lots      - sets the fixed lot size. If Lots = 0 then AutoLot is 
activated. (Money management is on)

• FapTurbo_LotsRiskReductor      - the percentage of free margin used to 
open a new position. It is used only if FapTurbo_Lots  = 0.  To let FAPTurbo 
use money management (meaning that the EA decides the lot size itself), 
the variable Lots should be set to zero. LotsRiskReductor will then define 
the risk size. LotsRiskReductor can be from 1 to 100.  

• FapTurbo_MaxOrders   - Maximum number of opened orders at the same 
time

• FapTurbo_MaxLots   - Maximum Lot size

• FapTurbo_StopTime              - Time delay between first and second opened 
order (if Maxorders=2 or more)

• FapTurbo_aaa                   - parameter for DeMarker indicator

• FapTurbo_bbb                   - parameter for WPR Indicator

• FapTurbo_TakeProfit            - Take profit in pips

• FapTurbo_StopLoss              - Stop Loss in pips. If Zero then it is not used.

• FapTurbo_TrailingStop          - Trailing Stop Value

• FapTurbo_DurationInHours       - Maximum time interval to keep the open 
position. This feature closes the open position when the time is elapsed. If 
Zero then not used. 



• FapTurbo_CloseAfterXmonths     - Defines the “every month” closure 
strategy. If you set CloseAfterXmonths = 1 it will close all positions on the 
first trading day (on first trading tick) of each month. If you set to 2 then it 
will close every 2 months etc. If you set it to Zero then it is not used.

FAPTURBO has 2 Moving Averages (slow & fast) that are used as a global trend 
indicator and their possible cross defines the risky trading zones that should be 
avoided. Our goal is to predict the possible MA cross zones and avoid trading 
during these dangerous conditions. 

• FapTurbo_PeriodMALarge         - period of slow MA Filter (Daily)

• FapTurbo_PeriodMASmall         - period of fast MA (Daily)

• FapTurbo_PriceMA_0_6           - PriceMA_0_6 – the way of calculating MA. 
0=PRICE_CLOSE, 1=PRICE_OPEN, 2=PRICE_HIGH, 3=PRICE_LOW, 
4=PRICE_MEDIAN, 5=PRICE_TYPICAL, 6=PRICE_WEIGHTED

• FapTurbo_TypeMA_0_3            - type of МА: 0 = Simple, 1 = Exponential, 2 = 
Smoothed, 3 = Weighted

• FapTurbo_ShiftMALarge          - MA Shift in Daily bars for slow MA

• FapTurbo_ShiftMASmall          - MA Shift in Daily bars for fast МА

• FapTurbo_LookForDays           -  the number of daily bars to count back from 
the current bar to calculate possible MA Cross. Used if 
FapTurbo_CriticalDays > 0

• FapTurbo_CriticalDays          - the number of critical days after the expected 
cross of MAs. If zero then it is not used. If we expect an MA Cross then 
FAPTURBO will miss dangerous trading days.

•  FapTurbo_RelaxDays             - If zero then it is not used. The number of 
days to miss after the possible MA cross.

FAPTURBO longterm strategy has 2 parameters for Altering Positions to 
decrease the risk:

• FapTurbo_AlterPositions               - turns on and off the hedging feature. If 
Hedging is on (1) then Fapturbo will open (FapTurbo_MaxOrders >1) 
positions in both directions. This feature prevents us from opening a lot of 
similar positions in one direction. So when you activate it FAP will control 
and balance the number of positions in each direction. 



• FapTurbo_AlterPositionsLotReducer     - Opens every new added trade with 
decreased lot size. 0 – not used. For example, if AlterPositionsLotReducer 
equals 2 and first trade is opened with 1 lot then next trade will be opened 
with 0.5 lot, etc.

The following parameters help Fapturbo to find the critical and risky days and 
avoiding trading on critical days:

• FapTurbo_TradeNFP              - if Zero then Non-farm-payroll days are 
avoided. NFP days often bring huge price movements that are considered 
as risky and should be avoided. (NFP occurs one day per month)

• FapTurbo_TradeFriday           - if Zero it does not trade on Fridays. Market 
behavior is usually unpredictable on Fridays and should be avoided. 

• FapTurbo_Prudent               - If 1 (on) then Fapturbo will be very careful and 
miss all risky days when slow and fast MAs are moving in different 
directions

• FapTurbo_SymAlligatorOnCritica – If 1 (on) then Fapturbo will trade with 
symmetrical Alligator indicator on the risky days when slow and fast MA 
have different directions

•  FapTurbo_FixedDirection        -  If on (1) then during the days when both 
MA are moving upwards  it allows trades in the BUY direction only. If both 
MA are moving downwards then it will only allow SELL trades. i.e.  the 
global trend is followed strictly.

•  FapTurbo_ClsLsrOnMrktChnge     - If on (1) then it closes all open losing 
trades if their direction is opposite to the MASmall. 

• FapTurbo_AlwaysTrade           - If on (1) then it uses safe lot sizes 
(FapTurbo_LowLot) during dangerous days.

• FapTurbo_LowLot                - safe lot size for dangerous days. It is used only 
if FapTurbo_AlwaysTrade is on (1).

• FapTurbo_TooGoodToBeTrue       - maximum number of daily bars where 
both MAs are pointing in the same direction. If the trend is very stable for a 
long time – then is “too good to be true”. The longer a strong trend has 
been sustained the more dangerous and unpredictable this trend becomes. 



• FapTurbo_PrudentPeriod         - Number of days after 
“FapTurbo_TooGoodToBeTrue” event that should are considered as risky 
days.

“StartWork” and “EndWork” Setting. During this interval (in broker time) 
Fapturbo will look for new signals to open positions. During other times it does 
not open new positions, only monitors positions which are already open. If Start 
and End time are the same then it works around the clock.  For example if you set 
StartWork TimeHour = 12, StartWork TimeMin = 20 and EndWork TimeHour = 17, 
EndWork TimeMin = 00 then FAPturbo will open new trades every day only 
between 12-20 and 17-00. During other times FAPturbo will only monitor old 
opened trades but never open any new trades.  

• FapTurbo_StartWorkTimeHour     - hour to start the trading interval

• FapTurbo_StartWorkTimeMin      -  minute to start the trading interval

• FapTurbo_EndWorkTimeHour       -  hour to stop the trading interval

• FapTurbo_EndWorkTimeMin        - minute to close the trading interval

• FapTurbo_OneTrade              - opens only one trade during the defined 
Trading Interval.

• FapTurbo_SpanGator             - Alligator indicator parameter

• FapTurbo_SlipPage              - Maximum price Slippage              

• FapTurbo_ExpertComment         - Comments FapTurbo for Log

General Settings

• Magic Number - This is a unique ID number for each advisor to help the 
system understand which Advisor is making the trade if you use several 
Expert Advisors in one trading account.

• ColorBuy                       - color for displaying Buy positions

• ColorSell                      - color for displaying Sell positions



• WriteLog                       - writes comments to Log

• WriteDebugLog                  - Writes comments to Journal

• PrintLogOnChart                - prints comments on Chart

• SoundAlert – you can set the sound notification of new trades made by 
fapturbo

• - SendEmail – you can setup metatrader to send you emails about new 
trades opened or closed by fapturbo. You can configure these email 
settings in MT4 Tools->Options>Email . Read the MT4 help for more 
information on this setting.

• KEY - The activation key for your copy of FAPTURBO.



FAPTurbo Trading Proof & Examples

FAPTURBO is famous as the first real money trading robot. We 
do trade real money with our system because we really trust it.

You can verify all statements and see the results in real time on our website 

http://www.FapTurbo.com

Short Term Scalper Strategy Forward Test

Short Term strategy can work on 4 pairs: EURGBP, GBPCHF, EURCHF and USDCAD, 
M15 Timeframe

Forward Test result: deposit was doubled in 2 weeks. 

(High-risk lot settings were used. Not recommended for new traders. For safe 
trading use lot = 0.5 for 5K deposit, or lotsriskreductor = 10 or less)

http://fapturbo.com/


We have a lot of real money trading accounts of different sizes: from 300 USD to 
50K. All of them are traded by FapTurbo with the same great result. This proves 
that you do not need a large deposit to make FAPTURBO work.

Even with small accounts, you can get excellent results, but if you are selecting lot 
sizes manually you should be very careful to use an appropriate lot size for your 
account (make sure you trade with a broker who accepts microlots). 

On all accounts, large and small, if you are using money management then you 
should be careful not to use a figure too large for lotsriskreductor (see previous 
section on risk and money management).



Long Term Advanced FAP Strategy Forward Test

• Here is an example from one of our FAPTURBO trading accounts. It 
generated $4,256 USD in 4 weeks on a $10K deposit. That is 42.57% profit. 
You can verify it via 3rd party monitoring at Onix Trade  After this test we 
stopped using demo accounts and went live.

Live (Real Money) trading accounts and statements can be found on our 
official website FAPTURBO.com.

http://www.onix-trade.net/?act=stat&id=4171


FAPTurbo Backtesting on Historical Data
Backtesting on historical data is a good way to see how a system behaved in 
the past. Of course past performance cannot guarantee future results and that 
is why we show real money forward tests too. Even so, with a fair amount of 
accuracy we can see how well the system performed during the last 9 years, 
giving us confidence going forwards into the future. 

• FapTurbo Scalper strategy can be backtested from 1999.

• Fapturbo Long Term Strategy can be backtested from 2003 because it 
trades only EURUSD M1 and there was no euro prior to 1999.

If you are not a forex expert you do not need to perform any backtests or 
optimizations. Just use the default settings and set proper lot size/risk (and 
GMT offset) and you are all set.

FAPTURBO is a very complicated robot with 2 strategies and for this reason 
backtesting can be very slow, particularly if you have an old PC.

History Data Download

First you should download the historical data for backtesting.

1. Open MetaTrader MT4 platform.
2. Go to “tools” then “options” in the upper menu bar.
3. Click Charts tab.
4. Change both “Max bars in history” and “Max bars in chart” to “999999999”.



5. Close Options window.
6. Open History Center in the Tools tab in upper menu bar.
7. Double click EURUSD M1 button.
8. Click “Download” button. (This downloads history data from MetaQuotes)

9. Do the same for other pairs you want to backtest. For example EURCHF and 
EURGBP for scalper strategy.
10. When the download is complete, close the History Center window.



You are now ready for Strategy Tester (backtests) and Optimization.

Please note that for M1 timeframe maximum modeling quality is 25%. That is 
normal because M1 is the smallest available timeframe for simulation in MT4. 
This does not mean that simulation is inaccurate.

Known Questions and Problems:

• How do I perform a backtest myself?
To perform a backtest, you should press CTR+R or View->Strategy Tester 
in main menu in Metatrader4.
Then select the expert advisor to backtest, the proper currency symbol, 
time interval (Use date), period. Also make sure you enter in your 
activation key and any other settings into the “expert properties” box. 
Click OK. When the backtest is finished you will see the results in 
“Results” or “Graph” and “Report” Tabs below.

• Strategy test does not work!
You may have forgotten to download historical data and/or activate your 
copy of the FAPTURBO. Also check that you have "allow DLL imports" 
checked in the global settings of Metatrader (Tools -> Options).

• My Metatrader crashes when I try to backtest!
That means you are using an outdated MT4. Please update it to the latest 
build.

• What is optimization and how do I do that?
Optimization works by making successive backtests of the same expert 
advisor with different inputs on each occasion. In this way, parameters can 
be found at which the expert advisor efficiency will be the greatest. 
Metatrader possesses some built-in means that allow for automating this 
process. To optimize an expert, you have to tick the option of the 
parameter(s) you want to optimise in the "expert properties" window- as 
well as specifying a range for which optimisation should occur over- before 
pressing the 'start' button. Do not make optimizations if you are not a 
forex/Metatrader expert. 



• My scalper strategy backtest shows worse results than yours?!
The problem could be the spread value. You can backtest ONLY if your 
spread for EURGBP = 3. If your spread is higher then the backtest will show 
different results. Also watch out for the possible switch from summer to 
wintertime in your broker (and hence differing GMTOffset values at 
different times of the year). You cannot get good results when trying to 
backtest with an incorrect GMT Offset.



FAQ & Troubleshooting: 
GENERAL FOREX QUESTIONS

What is Forex?

The Foreign Exchange market, also referred to as the "FOREX" or
"Forex" or "Retail forex" or "FX" or "Spot FX" or just "Spot" is the
largest financial market in the world, with a volume of over $2
trillion a day. If you compare that to the $25 billion a day volume
that the New York Stock Exchange trades, you can easily see how
enormous the Foreign Exchange really is. It actually equates to more
than three times the total amount of the stocks and futures markets
combined! Forex rocks!

What Tools Do I Need to Start Trading Forex?

A computer with an Internet connection or virtual private server for
remote trading is all that is needed to begin trading currencies. We
provide full detailed instructions so no forex knowledge is needed.

What trading software do I need to run FAPTURBO and where do I get it?

FAPTURBO is designed to work with the forex trading platform
Metatrader 4, which is now offered by many of the leading forex
brokers. Metatrader 4 can be downloaded for free from most brokers’
websites, usually via a "download trading platform" link.

What is Expert advisor (EA)?

Expert Advisor is an automated robotic script written in MQ4 language
that can work in the Metatrader4 platform and make trades for you!

Can advisors work when I am away or go out?

Yes, they can work 24 hours/day for you. You don't need to monitor the
trades if you don't have enough free time. Our Robot Advisors will
monitor the trades, open orders and close positions for you when
needed. Just keep your MetaTrader on to let them work their magic!

What if my PC lost power or rebooted?

No problem here! Just run Metatrader again and turn on the expert
advisor. It will continue trading. If you have continuous power losses
and poor Internet connection or simply cant keep your PC online all
the time we suggest that you order VPS (Virtual Private Server) for
hosting your trading.

How do I remove expert advisor?

To remove an advisor, just right click on its name or face in the top
right part of the chart and select «Expert Advisors -> Remove». Don't



forget to close all open trades of the current advisor if you remove
it.

Should I remove or turn off the expert advisor on weekends?

No need to do that. It will sleep when the market is closed and
continue to work on Monday automatically.

Does FOREX work 24/7? 

No. Only on business days. No trading on weekends.

What is Virtual Private Server (VPS)?

VPS is a special service that can host your trading on a remote server
so you no longer need to keep your PC on 24/5 for trading!

Demo or Real account?

You should always try your expert advisors on Demo account first to
check if your broker is compatible with your current expert advisor!
We don't recommend trading on Real account without testing on Demo
first!

Can I run several advisors on the same account at the same time?

That's a great idea! You can run several advisors simultaneously to
increase your profits and minimize the risks. Don't worry if it sounds
daunting – we'll give you full instructions on how to do it.

Can I run FAPTURBO with other EAs or with manual trading?

Yes, you can. The magic number feature will help FAPTURBO to separate its
trades from other trades.
Magic number is the unique ID number of each advisor to help the
system understand which advisor is making a trade if you attach
several advisors at the same time.

Brokerage And Trading Setup

What broker should I choose?

To get the Robot EA (Expert advisor) up and running you need to trade
on the popular Metatrader 4 platform. Basically you can use any
Brokerage you like, however we arranged a special deal with the
forex-meta guys. They will credit your real money account with up to
USD $500 in bonus money after you’ve traded for a given time (the robot
usually makes a few winning trades a day so that goal is easily
archived) PLUS they know about the EA robot setup and are willing to
assist you should any problems occur. OPEN AN ACCOUNT WITH FOREX META
NOW (http://www.forexmeta.com/forex).

http://www.forexmeta.com/forex


What is Metatrader4 and where can I download it?

Metatrader4 is a free trading platform. You can download it from your
broker website.

What are the top brokers with metatrader4?
1. IamFX http://iamfx.com/ (raw interbank spreads STP broker)
2. FXCBS http://fapturbo.com/brokers.html
3. ForexMeta http://www.forexmeta.com/forex
4. Alpari UK http://alpari.co.uk/
5. FXCM UK http://www.fxcm.com/metatrader.jsp

How do I Install Metatrader4?

Please watch our video tutorials in the "VIDEO TUTORIALS" section in the
member area.

How do I get my $500 USD Bonus?

The $500 bonus credit to the account is subject to the client
completing at least 40 full lot closed trades within the first 60 days
of the account approval. Bonus is provided only by ForexMeta broker,
not by FAPTURBO developers. Other brokers do not provide this signup
bonus.
Contact ForexMeta directly to claim the bonus.

I have MAC OS. Can Metatrader4 work on MAC?

Metatrader4 was created for Windows only but there are 2 ways you can
still use it on MAC OS. Best way is to order VPS Service ForexHoster.com
that can work with MAC OS without any problem.

Getting Started With FAPTURBO

Do I have to trade myself? Is it difficult to setup?

No! All you need to do is setup the automated trading robots (expert
advisors) and let them trade on your account to bring you profits! You
will get step-by-step instructions how to setup and run them and we have
prepared a great set of Video Tutorials for you!

How do I install FAPTURBO?

Download FapTurbo Easy Install Package from the Downloads section in
the member area and Run it. It will guide you through the setup
process. Also please watch our video tutorials in "VIDEO TUTORIALS"
section in the member area.

http://www.fxcm.com/metatrader.jsp
http://alpari.co.uk/
http://www.forexmeta.com/forex
http://fapturbo.com/brokers.html
http://iamfx.com/


Can I install FAPTURBO manually without "FapTurbo Easy Installer"?

Yes. Download the FAPTURBO package ZIP file that contains
FAPTURBO.ex4 file (place it to the /experts folder in metatrader)
FAPTURBO3.DLL file (place it to the /libraries folder in metatrader)
and FAPTURBO GUIDE in PDF (adobe acrobat reader)

How much money do I need to start trading?

Depending on your broker terms, you can start trading with as little
as $100. Remember that starting out with low trading capital may put
you at disadvantage because you will only be able to trade the market
in small  sizes. We recommend that you start with capital of
$1,000-5,000 USD or train on a Demo account till you are satisfied
with the performance.

Is it hard to learn and implement your trading system?

No! Most people that purchase the FAPTURBO package start trading within
minutes of installing. We provide detailed instructions and cool Video
Tutorials! Please watch our video tutorials in "VIDEO TUTORIALS"
section in the member area.

Where can I get WinZip to unzip files?

You can download free WinZip Evaluation Version
http://www.winzip.com/downwz.htm to extract the Zip archive or just
use the free WindowsXP/Vista zip service. You can also use free WinRAR
to unzip files: http://www.rarlab.com/

Where can I get the Adobe Acrobat Reader to open PDF guide?

Download Adobe Acrobat Reader on http://www.adobe.com for free.

Where is the folder of metatrader experts? I can’t find it on my PC!

The common folder of metatrader experts is:
C:\ProgramFiles\Metatrader4\Experts or C:\ProgramFiles\InterbankFX
Trader\Experts or similar.

How do I place FAPTURBO on VPS?

First of all you should order the ForexHoster VPS service (http://forexhoster.com). Then upload the 
fapturbo files from the FAPTURBO ZIP Package (can be found in member area download section).
Read the VPS service manual/videos for more information.

FAPTURBO Activation

http://fapturbo.fxhoster.hop.clickbank.net/
http://www.adobe.com/
http://www.rarlab.com/
http://www.winzip.com/downwz.htm


How do I Activate FAPTURBO?

Please read the FAPTURBO GUIDE "activation" section. We explained it
there in detail. Also watch our video tutorial. http://fapturbo.com/activation.htm 

I don’t get the "Activation Alert" (Alarm)!

Maybe your copy is already activated or you forgot to check "allow DLL
imports" and remove "Confirm DLL function calls" in the EA settings.
Another possible reason: Today is a non-trading day (weekend or Friday,
for example). Wait 2-3 days for this alert to appear. It will appear
during only trading days. Also check you have installed all files correctly. 

How to find out when my License will expire? 

Your license is valid for one month and then you should download a new license for free from the 
members area.
You can find out the expiration date on your licence if you move your mouse over the FAPTURBO EA in 
the Navigator TAB in metatrader and hold it there for a second. 
Also new versions print this information on the chart

My Metatrader crashes when I try to attach EA to the chart!

That means you are using an outdated version of MT4. Please update it to the latest build

My FAPTURBO License has expired. What should I do?

We update FAPTURBO approximately every month to make sure it is always up to date to
the modern market conditions. You should download the fresh version of
fapturbo from the member area and install it instead of the old
version.  All updates are FREE to our members.

FAPTURBO Settings and Configuration

Can I adjust parameters of the FAPTURBO advisor?

Of course…you can change stop loss, take profit and several other
parameters and filters depending specifically on your needs. All of them
are described in the FAPTURBO GUIDE. Make sure you set proper
parameters such as GMT Offset.

What timeframe and currency should I choose?

FAPTURBO has 2 built-in strategies. Each strategy is designed for its
own timeframe and currency pairs. For example Long-term strategy works
only on EURUSD M1. The scalping short-term strategy works on 4 pairs:
EURGBP, GBPCHF, EURCHF & USDCAD, M15 Timeframe. Read the GUIDE for
more information.

http://fapturbo.com/activation.htm


What are the differences between FAPTURBO Short Term and Long Term Strategy?

FAPTURBO is a powerful combination of 2 strategies: Short Term
Scalping Strategy and Long Term Advanced FAP strategy. Both strategies
are built inside one FAPTURBO expert advisor and can be switched on
and off easily using UseScalperStrategy parameter in FAPTURBO
settings.
Each strategy uses its own designed timeframe and currencies so be
sure you use the strategy on proper currency pair and timeframe. You
will find full details on each strategy and its parameters in the
FAPTURBO GUIDE and Video Tutorials

Which strategy is the best one?

There is no clear answer to this question. Every strategy is a unique
system of trading, and each has its own strong and weak points. We
recommend running both systems at the same time. You know,
diversification is the key to success!

How do I switch between Strategies?

Use UseScalperStrategy Parameter. True = Scalper strategy. False =
Long Term strategy.

Can I run 2 strategies on one account?

Yes you can. Attach FAPTURBO EA to the proper charts and set proper
parameters for each strategy. Read the GUIDE and watch our video
tutorials in "VIDEO TUTORIALS" section in the member area.

Warning: What are the most important parameters that I have to change?

In scalper strategy you should set the proper lot size and GMT OFFSET!
In long-term strategy you should set proper lot size.
And of course the KEY value with your activation key.
Please watch our video tutorials in "VIDEO TUTORIALS" section in the
member area.

How do I Set Proper Lot size?

Use lot = 0.01 for deposits less than $1000 USD. Use lot = 0.1 for deposit from $1001 to $4999 Use lot = 
0.5 for deposit from $5000 to $9999 Use lot = 1 for deposit $ 10K and above. The numbers could vary 
depending on your broker rules! Please watch our video tutorials in "VIDEO TUTORIALS" section in the 
member area.

What is GMT OFFSET Parameter?

GMT OFFSET is very important parameter for scalper strategy. It
defines the offset in hours between GMT and your broker time (market
watch in MT4). It should be set carefully in order to let Fapturbo
work properly. If you fail to set the GMT offset carefully you can get



unexpected losses. Please be careful! Ask your broker about their GMT
Offset if you are not sure!
Please watch our video tutorials in "VIDEO TUTORIALS" section in the
member area.
Now(since V47) Fapturbo has an automated GMT offset, but you need to use manual GMT offset for 
backtesting

What does Magic number mean in the expert advisor??

Magic number is the unique ID number of each advisor to help the
system understand which advisor is making a trade if you attach
several advisors at the same time. 

My Market Watch is frozen! How do I set GMT Offset?

Please note if your Market Watch is frozen that means that your broker
is on the weekend holiday and that broker time is not valid for GMT
offset. You should wait until your broker is on a trading day to set
the proper GMT offset value!

How do I change the parameters after I attached the EA to the chart?
Right click on the smiling face and select "Expert Advisors - >
Properties" or press F7
Double click on parameters in INPUTS Tab to change them!

What is a Stealth Mode?

Stealth Mode protects you from cheating on the broker side. Using the
stealth mode the take profit and stop loss values are not displayed to the
broker. 

FAPTURBO Backtest and Optimization

How do I perform a backtest on history?

If you are not a forex expert you do not need to perform any backtest
and optimizations. Just use the default settings and set proper lot
size (and GMT offset) and you are all set!
FAPTURBO is a very complicated robot with 2 strategies and that's why
backtest is very slow. Do not run backtest if you have a slow PC.
First you should download the historical data for your backtest calculation.
To perform a backtest, you should press CTR+R or View->Strategy Tester
in main menu in Metatrader4.
Then set the expert advisor to backtest, the proper symbol, time
interval (Use date), period and click OK. When backtest is finished
you will see the results in "Results" or "Graph" and "Report" Tabs.
Read the FAPTURBO GUIDE for more info.

Strategy backtest does not work!!



I guess you forgot to download historical data or your forgot to
activate your copy of the EA and "allow DLLs" in the global settings
of Metatrader (Tools -> Options)

My Metatrader crashes when I try to backtest

That means you are using an outdated MT4. Please update it to the latest build

What is optimization and how do I do that?

Optimization represents successive passes of the same expert advisor
with different inputs on the same data. Such parameters can
be sorted out at which the expert efficiency will be maximal. The terminal
possesses some built-in means that allow it to automate this process. To
optimize an expert, one has to flag the option of the same name in the
"Tester" window and press the "Start" button. Do not make
optimizations if you are not a forex expert!

My scalper strategy backtest shows totally different, bad results than yours!

The problem is in the spread value. You can backtest ONLY if your
spread for EURGBP = 3. If you spread is higher, then backtest will show
invalid results. Also mind the possible summer-winter time switch that could occur twice 
a year at your broker! You cant backtest well with invalid GMT offset!

Specific FAP And FAPTURBO Questions

What is Forex Autopilot (FAP)?

Forex Autopilot (F.A.P., ForexAutoPilot.com) is a fully independent
software robot which trades the foreign exchange currency market on
autopilot 24 hours a day. Robots such as Forex Autopilot are called
"Expert Advisors" or EAs, and are attached to the currency charts in
the trading platform software which is provided by forex brokers.
ForexAutoPilot was created by Markus Leary and his team.

What is the difference between FAP and FAPTURBO?

FAPTURBO is built on the FAP (Forex Autopilot) engine but it is a whole
new generation of product. FAPTURBO developers have added great number of
new features to FAP Algorithm to make it More Safe and More Profitable.
Now FAPTURBO FAP strategy uses fixed stop loss value so your possible
losses will be small and limited. A great number of additional safe
filters and indicators were added to prevent trading in risky
conditions. Advanced filters and indicators that were added to the
system make sure FAP avoids risky periods with unstable market and
makes most of the profitable trades with high accuracy.
Plus a new short-term scalper strategy is introduced in FAPTURBO that
works on 4 pairs and showed great results in live real money trading.

What is the percent of winning trades?



According to history backtests from 1999-2008 and live trading results
FAPTURBO EA makes 96% of winning trades. You can always perform
backtest yourself to check that.

I did not like the "no stop loss idea" in FAP. How about that in FAPTURBO?

FAPTURBO FAP strategy uses fixed stop loss value so your possible
losses will be small and limited. A great number of additional safe
filters and indicators were added to prevent trading in risky
conditions.

FAPTURBO Support

Do you provide support?

We provide rapid email support and Phone support to our members. Feel
free to contact us if you have any questions or problems at support@fapturbo.com. Please give us 24-48 
hours to reply.

Where can I get premium paid first priority support?

Join fap-winner.com club for premium paid first priority support on fapturbo (12 phone lines, live chat, 
appointment calendar etc)

Do you provide Video Tutorials?

Sure, we have prepared a bunch of cool video tutorials for you and a
perfect step-by-step FAPTURBO GUIDE! You can find them in the member area!

What is FAPWINNER.com? 

FAPWINNER.com (FAP-WINNER.COM) is a special service for
ForexAutoPilot & FAPTURBO clients with premium support (rapid support,
Live Chat, Appointment Calendar, Forum, Phone support) and advanced
trading opportunities (Special FAP settings, Personal Trading Plan,
Hedging EA) as well as weekly Mentoring and Coaching Class and
Seminars/Webinars.
FAP-Winner was founded by Charles A. Floyd II, professional forex
trader with 20 years of experience.
FAP-Winner is not a part of FAPTURBO or FAP service, it is a separate
product created by Charles A. Floyd, II.

Do you have a private member FORUM?

A forum is a part of the FAPWINNER.com service. All FAPWINNER members have
access to the private discussion forum where all your questions can be
answered. You can discuss anything related to FAP and FAPTURBO including
setup, effective strategies, usage and settings.
Fapturbo.com also has private member forum.

http://FAP-WINNER.COM/


Is FAPTURBO Legal?

FAPTURBO and FAPWINNER partners are 100% legal services. FAPWINNER,
LLC is proud to be an authenticated Limited Liability Company in good
standing with the State of Illinois. Address: 4710 Lincoln Hwy, Suite
234, Matteson, Illinois.

Problems & Troubleshooting

I can’t activate my Copy!! My expert ID=0!! Help me!

This is a common but easy to fix glitch in Metatrader4. First check
the EA settings. Turn on "Allow DLL imports" and remove "Confirm DLL
function calls" there. Also check the global parameters of the
Metatrader: Tools -> Options -> Expert Advisors. Turn on "Allow Dll
imports" and turn off "Confirm DLL function calls". Then restart
Metatrader! You must restart your Metatrader and try again! It
helps. If it happens again in future then just restart your
metatrader.

My Metatrader crashes when I try to run Fapturbo!!

That means you are using an outdated MT4. Please update it to the latest build.
Contact your broker if you can’t update your MT4 manually.

I installed FAPTURBO but I don’t see it in the NAVIGATOR Tab in metatrader!

The problem could be that you have several Metatraders installed on
your PC. Check if you installed FAPTURBO to correct folder of the
correct MT copy.

I have the little smiley face in the right top corner, but it is not
doing anything.

If the face is smiling and the broker information is showing on the left of the chart
that means the EA is working correctly. It will
open trades when it identifies the proper market situation. Have
patience. It will open new trades sooner or later (often during first
few days). Most of the advisors don't open the new orders instantly
after you run them! Advisor is monitoring the market and opens its
trades only on condition of possible profits!

I have a large draw down on my open trade. What's wrong? Am I losing money?

There is no problem here. Your trade is not closed yet. Have patience.
Drawdowns are a normal part of the Forex investing landscape and they
must be expected. FAPTURBO is not a crystal ball, it is a system that
uses various technical indicators to enter and exit trades.



FAPTURBO has a built-in Stop Loss value so even if you experience a
losing trade the loss will be limited by the Stop Loss value.
You should know that All trades stay in minus for some time. The Forex
Market always has price movements in both directions - there is no
problem here. You can backtest on the EA history to better understand
how it works. A current minus does not mean a loss, because the trade
is Open. Only closed trades can be considered losing trades. FAPTURBO
makes 96% winning trades

Why do my trades start in Minus?

Please note that all new open trades stay in minus for some time
because you have to pay the "spread" (commission) to the broker! That
is not a problem. Sooner or later most of the trades will close in
profit. Have patience.

When I drag the expert advisor onto a chart, I don't get the smiley
face, just an X. I follow the procedure but it still doesn't respond.

The Smiling Face icon means that EA works correctly. If you don't see
the Smiling Face, just click on the "Expert Advisors" button on top of
the Metatrader menu.

I see the sad face :( of the expert advisor instead of smiley face :)

If you see the Sad Face that means you forgot to set "Allow live
trading" parameter for the expert advisor. Please check the
parameters.

Why are some expert advisors shown in grey in the NAVIGATOR TAB?

Experts-Robots are shown in grey because they don't have open source
codes. That's fine. It is not the problem at all. They will still work
fine if they have the Smiling Face on the top right of the attached
graph. Template MT4 experts like "MACD Sample" and "Moving Average"
are free samples with open source and that's why they are shown in
yellow.

I can’t activate my copy because the Activation ALARM does not appear!!

Maybe your copy is already activated or you forgot to check "allow DLL
imports" and remove "Confirm DLL function calls" in the EA settings.
Another possible reason: Today is a non-trading day (weekend or Friday,
for example). Wait 2-3 days for this alert to appear. It will appear
during only trading days.
If you have installed manually then you may not have the .dll file installed, or have put
it in the wrong place.

FAPTURBO doesn't trade! What am I doing wrong??

If FAPTURBO does not open a single trade after 1 week that means



something is wrong here.
Here is what to do:
-First of all, please carefully check all the setup steps according to
the FAPTURBO GUIDE.
-Make sure you have a smiling face of FAPTURBO EA on the right top
side of the Chart.
-Check if your copy is activated.
-Check the Log or Journal for possible errors. Contact our support for help.
-Check if the FAPTURBO3.DLL exists in the expert/libraries folder in
your Metatrader
-If you trade FXPro and other brokers that do not allow the microlots set the TradeMicrolots = false 
position otherwise it will not trade.
-Check that your broker has spreads of 5 or below for the pairs you are trading. You will not get trades if 
the spread is greater than this

I see "Requotes or Off Quotes" and "Trade context is busy" ERRORS in Journal! 
Requotes and trade context is busy errors happen on the broker side from time to time. We cant do 
anything about it. That is part of live trading and they should be expected. Such errors decrease 
profitability comparing to demo accounts but do not harm the system. 

I get the error "No money to open more orders."?

That means that your deposit is too small for the current level of
risk. Try to increase your deposit or decrease the lot size. For
example, change the lot size from 1 to 0.1 in EA parameters.
Also check that you have leverage of 100:1 or greater. 

I get "alligator jaw error”!

In most cases all Alligator jaw errors mean is a temporary connection to
broker error. You can skip them. Such errors are removed automatically
when connection is established again.

I get error "Trade is not allowed".

That could mean you logged in using the Investor password instead of
Trader password or forgot to "allow live trading" in EA settings

My orders are opened with Zero stop loss and Take profit!! Help me!

There is no problem here. You are using Stealth mode. Stealth Mode
protects you from cheating on the broker side. Using the stealth mode
the take profit and stop loss values are not displayed to broker. That
does not mean that your order does not have stop loss and take profit.
It is "inner" and not visible.  FAPTurbo will place fake take profit and stoploss 
levels but these are placed after the trade has already opened since
some brokers do not allow placing of stoploss and take profit at the time
of opening the trade.

I get "order send error".

Check the take profit and stop loss settings. Some brokers do not
allow scalping. Enable the Stealth mode.



My trading results are bad. What is wrong?

There could be a few possible reasons:

1. First of all please carefully check all the setup steps according
to the FAPTURBO GUIDE.
2. If you use the Scalper strategy check the Spread value. It should
be 3-5 for EURGBP or less for proper trading. Take into account that
some brokers increase the spread value at night and cheat you! Check
spread at night too.
3. For scalper strategy make sure you use PROPER GMT OFFSET. Failing
to set the proper GMT OFFSET will result in a loss and bad trading!
Read GUIDE for more details!
4. Please note that when trading with any forex strategy you should take into
account that your goal is to make a profit long term. You should check your results
monthly or quarterly, not every day or every week. The idea here is to
make you a profit in the long run! So have patience and you will be amazed by
how well it works!

My trading results differ from yours on site.

Trading results could differ in different brokers and even inside one broker. That is normal.
Demo and Real accounts have different spread size and different order execution times so results could 
vary too. That is not a problem.
Don’t forget to double check GMT Offset parameter!

My Scalper Trade was not closed on time! What happend? 
Maybe you had a disconnection issue or requotes problem that prevented FAPTurbo from closing the 
position in time. That sometimes happen on the brokers side. If you have a poor connection we 
recommend ordering a VPS server to host your trades. Also you can close such invalid trades manually 
later. 

My Spreads for EURCHF and GBPCHF are larger than 3! What to do!? 
Spread must be 3-5 for main pair EURGBP. For other pairs spread can be larger. it's OK! 

Have a nice trading
Steve, Mike, Uli

http://forexwinners.net/

